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MoonSked 1.4

A Moon Bounce Scheduling program, designed for Radio Amateur EME enthusiasts.

MoonSked and this documentation are copyright © David G.L. Anderson, GM4JJJ, 1999-2002

Available for both the Apple Macintosh and the PC Windows platform.

MoonSked  is ShareWare, the Registration page is
http://www.gm4jjj.co.uk/MoonSked/moonsked_registration.htm

David Anderson
Braeside
Urquhart
Crossford
Fife
KY12 8QL
Scotland, U.K.

Email: gm4jjj@amsat.org

Web pages: http://www.gm4jjj.co.uk

Like most users you probably don't need to read the documentation to run the software, however to get
the most from this program, you may find the following pages explain some features...

• Shareware Registration

MoonSked is distributed as shareware. It is a demo copy and you may try it for 30 days, after which we
ask that you either delete your copy or register it online .The shareware fee is $30, upon registration,
you will receive free technical support, free upgrades, and a code to disable the reminder messages
which appear at regular intervals as well as add the new features which are available only with the full
version.

The Registration page is http://www.gm4jjj.co.uk/MoonSked/moonsked_registration.htm

Please include your Amateur Radio Callsign, it is used to generate your registration code.

If you have any problem with registration please contact the author by email at gm4jjj@amsat.org

• Differences between Macintosh  and Windows PC versions

The screen shots shown are from the Macintosh version of MoonSked.
There may be minor cosmetic differences between the Windows and the Macintosh versions.
Where possible the functionality is exactly the same, while trying to keep to the recommended human
interface guidelines for the platform.

Some features of the Macintosh version are not available on the Windows Version due to
hardware/software limitations of the Windows platform. e.g. There is no Map Control Panel on a PC.

Menu Key short cuts on the PC are CTRL and the letter, while on the Mac the Command Key is used.
ESC is used to cancel a predictions calculation on the PC and Command Period is used on the
Macintosh.

http://www.gm4jjj.co.uk/MoonSked/moonsked_registration.htm
mailto:gm4jjj@amsat.org
http://www.gm4jjj.co.uk
http://www.gm4jjj.co.uk/MoonSked/moonsked_registration.htm
mailto:gm4jjj@amsat.org
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Getting Started

• Installation
If you have read this far you have installed the software! MoonSked looks for its associated files within
the folder that it is located in. You can move the folder wherever you like but just leave the files inside
it where they are.

• Callsign Database file
The text file DIR.SKD must reside in the MoonSked Folder with the MoonSked Application to allow
the Callsign Database to load. If it is not there then you will not be able to enter callsigns in the
Preferences dialog panel. DIR.SKD is regularly updated and available by email. It may be also be
edited with a text editor.

VHFSCHED.SKD and FREQ.SKD files are used to make the SkedDatabase and FreqDatabase files
when they are imported.  See the Databases menu.

The Sked Maker window is the main result screen. It can be resized to fit the whole area of the monitor
if required.

Double clicking a line in the results box will open the schedules window and fill in the entry boxes
with the Date/Time and station information from the Predictions result. It also will fill in the frequency
with Station A's preferred sked frequency.
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The Prediction results are shown in the following columns:

• DATE - The date in the long format chosen by your settings in Date & Time Control Panel
• UTC - Time in standard UTC format
• AZ - Azimuth bearing in degrees of moon from home station (in blue)
• EL - Elevation bearing in degrees of moon from home station (in blue)
• MNR -  Maximum Non Reciprocity * See appendix .doc MNR by N1BUG. (Color Coded)
• POL - Spatial Polarity angle in degrees between Home and DX station
• AZ DX - Azimuth bearing in degrees of moon for DX station
• EL DX - Elevation bearing in degrees of moon for DX station
• DEC - Declination of the moon in degrees
• DGR - Additional Loss (dB) at 144MHz  or 432MHz (Degradation over ideal) Sum of losses over

'ideal' conditions. Additional path loss due to moon not being at perigee plus extra contribution
from additional sky noise over lowest possible.

• RX noise figure is taken as 60¡K at 144MHz and 30¡K at 432MHz. At 1296MHz the sky noise
contribution is assumed to be neglible.

• TSky - Background sky temperature in degrees Kelvin at the frequency chosen in the preferences.
(50,144 & 432 MHz only) Displays !Sun (in red) if New Moon.

• RGE Km -  is the Range the moon shown in Km.
• DOP - The Doppler shown in the DX station box is the net doppler shift of the DX station as

received at the Home Station.

• The Calculate button starts the moon predictions running, they can be aborted by pressing the
command key and period key at the same time. (ESC key on Windows PC)

• Start - Start Date for predictions - default today.
• Finish - Finish Date for predictions - default tommorow.
• Interval - Choice of 10, 30 or 60 minute time period intervals for the calculations.
• Home button  - makes Station A and B become the same.
• Next or Previous Weekend or Day -  Calculates again for the next or previous day or weekend.
• Today Button -  Calculates for today.
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The schedule window allows you to see  schedules for any station in the SkedDatabase by using the
FIND  button.

Once you find a sked or skeds they appear in the upper scheds list, if you select one of the skeds then
all the matching skeds for the other station appear in the lower list.

Schedules are taken from the VHFSCHED.SKD textfile which is updated weekly by email.
The SKD file has to be imported into a SkedDatabase to allow MoonSked to display  the schedules.

SkedDatabase and FreqDatabase are built from the SKD80 files VHFSCHED.SKD and FREQ.SKD.
When you edit or add a sked, you are altering SkedDatabase, not VHFSCHED.SKD.

DIR.SKD is required all of the time because it is not converted into a 'database'.

• Find Call

Skeds - shows only skeds for the found station.

All - shows all lines of data for the found station

Tip - Leave the callsign field blank and choose All to find all  info on all callsigns
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• Find and sort All Skeds

By Date - sorts all of the skeds in the database in chronological order.

By Call - sorts all of the skeds in the database in alphabetical order.

• Entry fields
The centre coloured edit fields allow you to create a new sked (+), edit an existing sked (=), and look
for a common skedtime on a day (?).

• Adding a new schedule
+ Button - Creates a new schedule using the information entered into the entry fields. Checks for
clashes with skeds at same time or on same frequency. Undo works.

• Amending an existing Schedule
= Button -  replaces the selected line in the upper list with the information in the entry fields. Undo
works.

• Finding a Sked time
? Button - takes the date and callsigns and opens up the predictions window and runs the calculation
for that day. You can then double click the time you want to sked and the schedule window will come
to the front again with the time entered in for you. Press the + Button to add the new sked. Undo
Works.

• Deleting a schedule
Highlight (Select with the mouse) the schedule or schedules you wish to delete in the upper sched list
and press the BACKSPACE Key (On Macintosh the DELETE key). You can use Undo in the Edit
menu to undelete. (Shortcut ControlZ)

• Database Import

VHFSCHED -  creates new SkedDatabase from VHFSKED.SKD file which must be in same folder as
MoonSked. Backs up existing SkedDatabase as SkedDatabase.bak – Note in the demo version this
function is disabled.

FREQ -  creates new FreqDatabase from FREQ.SKD file which must be in same folder as MoonSked.
Backs up existing FreqDatabase as FreqDatabase.bak

 Found - shows number of lines of data found for a station.

Copy to Clipboard in SKD80 format checkbox - If checked then skeds copied to the clipboard for
pasting into an email are in comma separated SKD80 format. If not checked they are in a more human
readable TAB separated format.

You can highlight (select) a group of skeds from either upper or lower lists and copy them to the
clipboard so you can paste them into the body of your email .

Email
e-mail addresses are parsed from the SkedDatabase so they will appear when you highlight a single line
in the upper  list. You can click on the email address and your email program should open a new
message to that station.
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Show Station Info
Station info taken from DIR.SKD,FreqDatabase and calculated Locator can be shown for both stations
in floating windows by selecting from the Window menu Station Info or simply by Control  I (This
toggles station info ON/OFF)

Menus
(Under the Help menu in Windows)
About MoonSked...
Information about MoonSked and special thanks to those who helped directly or indirectly.

Register MoonSked...
Enter your registration code here (after paying the Shareware fee).  If you have any trouble please
email the author.
The Register OnLine button will take you right to the Registration Web Page.

Edit Menu

Copy Ctrl+C
Allows copying of single of multiple selections from the result lists in the windows.

Select All Ctrl+A
Quick selection of all of the items in a result list.
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Preferences...

This is opened when the SELECT button is pressed or from the Edit Menu. Home station and DX
station can be chosen from this panel along with the band.

Enter either your Locator Grid square or your Lat/Lon and the other details will be calculated.

Click into or Tab between entry boxes.

The DX Callsign can be selected from the scrollable list or entered into the box and TAB will then
search the database for the callsign.  You can also enter the DX Lat/Lon or Locator for any station not
in the list.
The DX Callsign will then be shown as ‘DXstation’.

On  a Windows PC there is a ‘PC at UTC’ checkbox that you have to tick if your computer clock is
always set to UTC. Otherwise make sure you also have set your time zone in the Date/Time Control
Panel so that UTC is correctly calculated by MoonSked.

On the Macintosh the Date & Time control panel will control whether DST is in effect or not. A Sun
symbol is shown in the My Location Group box when DST is in effect.

The Band setting determines the calculated Doppler shift as well as the Sky Noise contribution.
It also determines which .SKD file is imported. VHFSCHED.SKD for 144MHz and SCHED.SKD
for 432MHz and above.

Click the OK Button when finished.
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 File Menu

Print…
Prints Schedules or Predictions (also MoonGraph)

Quit
Quits the Program!

Databases Menu
Import VHFSCHED - Registered Users only
Creates a new SkedDatabase from the textfile VHFSKED.SKD. Previous SkedDatabase will be
renamed SkedDatabase.bak.

Note:
If BAND Preferences are set to 432MHz or above then the file SCHED.SKD is imported instead
of VHFSCHED.SKD.
The file UHFDatabase is then created and the backed up as UHFDatabase.bak
This allows Multiband operators to maintain UHF and VHF databases.

Import FREQ
Creates a new FreqDatabase from the textfile FREQ.SKD. Previous FreqDatabase will be renamed
FreqDatabase.bak.

Window Menu

Sked Maker Ctrl+L
Selects the main Prediction window

Schedules Ctrl+S
Selects the main Schedule window

Station Info Ctrl+I
2 floating windows with info on both stations appear. This is a toggle on/off.

Moon Track Ctrl + M
Selects the realtime moon tracking window. (Floating Window in Windows version)

Noise Sources Ctrl + N
Selects the realtime SUN, Noise Source tracking window. (Floating Window in Windows version)

World Map Ctrl & W
Selects a World Map showing the Moon’s footprint – Size can be set in Preferences.
(Floating Window in Windows version)

Call Finder Ctrl+F
Finds valid EME callsign from partial callsign fragments. (Floating Window in Windows version)

Moon Graph Ctrl+G
Selects Chart of Moon data for a calendar month
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MoonSked Features

• Easy Interface allows rapid choice of suitable date and time for EME schedules
• Home station location from Map Control Panel
• Mutual Station AZ/EL data
• 144MHz/ to 24GHzDoppler shift between Stations
• 144MHz/432MHz Background Sky Temperature
• Database of Stations, Macintosh or DOS format of DIR.SKD file (CR or CR/LF)
• Scrollable list of stations in database
• Grid Location entry
• Display of Grid from Lat/Lon Input
• Moon Elevation Correction for Parallax and Correction for Earth's Oblateness
• Moon Range and DGR dB loss
• Spatial Polarity and Maximum Non Reciprocity
• Station details displayed from database
• Show split of DGR in terms of Additional Sky Noise and Distance.
• Choice of Intervals for results
• Viewing and editing of VHFSCHED.SKD files in a custom database.
• Find skeds for any station.
• List all skeds in chronological order.
• email address lookup from SKD file database.
• HotLinks email address shown to your email program.
• Checks for clashes of sked times or frequencies when creating new sked.
• Copies skeds in SKD80 format or plain text.
• Shows station's preferred sked frequency.
• Integrates Prediction window with Schedules window allowing auto sked entry.
• Radio Sky Map and Noise Source Tracking
• Realtime Moon Tracking
• TX/RX sequence calculator with optional audible alerts
• Moon footprint on World Map.
• Interface with EA4TX Automatic Rotator Control System (Windows Only).
• Moon Graph shows monthly moon data
• Callfinder – finds likely EME  callsigns from partial calls heard

Registered Users Only
• Import of VHFSCHED.SKD and SCHED.SKD files (VHF and UHF & Above Schedules).
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Moon Position is shown in realtime.

Note UTC is shown and is calculated from the local time and the Time zone info stored on your
computer.
Note:-  Summertime also has to be taken into account – see preferences.

• Best TX Polarisation (calculated from Spacial Polarisation and the Best Receive Polarisation)
• Moon Range graphical representation of Pathloss (Green, Yellow, Red)
• MNR result is also color coded.
• Same information as shown in the Predictions Window.
• Total Doppler shift of the DX station as received by you shown as well as the shift of your own

echo.
• AZ/EL Data can be sent to EA4TX ARS system.
• Can be reduced to show only basic info by clicking “less detail” triangle
• The Moon’s Phase is shown by the picture above the DX station.

Note: Unregistered Users will only be able to view this window for a limited time during any session.
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Realtime Noise Source Tracking  -

• UTC calculated from local computer time and Time Zone
• Note:-  Summertime (DST) also has to be taken into account – see preferences.
• Position of selected Noise Source shown on Radio Sky Map by flashing circle
• Sun position shown as yellow disc (not to scale)
• Moon Position shown by white circle ( 8 degree radius)
• Custom sources can be input by entering RA and Declination or by clicking on Sky Map.
• Ecliptic (path of sun) through the year) is shown  as a sine wave.
• AZ/EL data can be sent to EA4TX ARS system
• Different antenna beamwidths can be entered and the size of the circle around the source will

change.

Note: Unregistered Users will only be able to view this window for a limited time during any session.
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World Map

The World Map shows the present area illuminated by the Moon, the dark area is not in range of the
Moon.

The ‘footprint’ is updated in realtime.

The Position of Home & DX stations are shown.

The Position of the Sun and the Moon are shown.

The Phase of the Moon is shown graphically.

Clicking on the Map will display all stations in the database (red dot displays positions)

Note that there are two sizes of maps available – change in the Preferences.
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MoonGraph

The MoonGraph allows the user to see a whole month at a time.
New Moon when the Sun is in the same part of the sky as the Moon is indicated by a Sun symbol.
Weekends are shown in blue. Today ‘s date is shown in Red.
The size of the window is scaleable.
Dots for each day can be added to the graphs.
Any combination of the four plots can be displayed

Note: Un Registered users can only view the data for the previous month
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Using MoonSked with the EA4TX Automatic Rotator System

MoonSked can be used to create tracking data for the ARSWIN program by EA4TX. This will allow
automatic control of antenna rotators for tracking the Moon, Sun,  or other Cosmic Target.

The Tracking Tab Panel sets the time interval used for the creation of the AZEL.DAT tracking data file
created for use with the EA4TX Automatic Rotator System (ARS). If set to OFF then no AZEL.DAT
file is produced.

The ARSWIN Program is shown with the MoonSkedARS DDE Driver interface software taking data
from MoonSked’s Noise Source Tracking Window (Not Shown).

ARSWIN must be running before MoonSkedARS is started.

ARSWIN must be installed otherwise the Runtime Libraries used by MoonSkedARS will not be
present.
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Although I have no reason to suspect that this software could do any damage to either you or your
computer, for my protection I must include the following statement.

Legal Stuff - Standard Disclaimer

This is a legal agreement between you, the end user, and David Anderson GM4JJJ

Be sure to read the following agreement before using the software.

IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,
THEN PLEASE DISCONTINUE USING THIS SOFTWARE.

1 GRANT OF LICENCE  David Anderson GM4JJJ grants you the right to use one
copy of this software program (the "SOFTWARE") on an unlimited number of
computers within the confines of one building. You may not network the
SOFTWARE or otherwise use it or make it available for use outside of the one
building at the same time.

2 COPYRIGHT  The SOFTWARE is owned by David Anderson GM4JJJ and is protected
by  the Laws of Scotland and the exclusive jurisdiction of the Scottish Courts

3 OTHER RESTRICTIONS  You may not rent or lease the SOFTWARE, but you may
transfer the SOFTWARE and accompanying written materials on a permanent
basis provided you retain no copies and the recipient agrees to the terms of
this agreement. You may not modify, adapt, translate, reverse engineer,
decompile, or disassemble the SOFTWARE.

4 MISCELLANEOUS  This Agreement shall be governed by the laws of the United
Kingdom. If for any reason a court of competent jurisdiction finds any
provision of this Agreement or portion thereof to be unenforceable, that
provision of the Agreement shall be enforced to the maximum extent
permissible so as to effect the intent of the parties, and the remainder of
this Agreement shall continue in full force and effect.

5 DISCLAIMER  The SOFTWARE is provided "as is" without warranty of ANY kind.
The SOFTWARE was written and tested to be as accurate as current technology
will allow without harmful or damaging intent to the user's computer or
connected equipment. Risk for use of the SOFTWARE is assumed by the user and
not David Anderson GM4JJJ. Any damage cost will be assumed by the user and
not David Anderson GM4JJJ or it's dealers, distributors, agents or employees.
David Anderson GM4JJJ disclaims any responsibility or liability in connection
with installation of any material described in this software.


